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Abstract 

Mining activities creates wealth or economic surpluses. So many companies tend to 

explore, develop, and then exploit mineral deposits. Royalty is a payment made to the 

owner of mineral rights for the privilege of extracting the mineral from the ground based 

on a lease agreement. There are three methods used in the world for the royalty 

payments. Commonly, Unit based royalty, Value based royalty and Profit based royalty 

methods were used. There are advantages and disadvantages in every method.  

In Sri Lanka Royalty for mining minerals were taken by GSMB. Unit based and Value 

based systems are occupied in Sri Lanka. However an explosive based equation 

(indirect method) is used to determine the royalty for industrial minerals. Which is 

having no relationship with fragmentation of rocks. To overcome this current situation, 

several methodologies were listed and carried out in this research, i.e. Photogrammetry 

Volume calculation and Total station survey volume estimation. Both methods are 

direct methods to calculate Royalty.  

Initially an A grade quarry was selected. Then a total station survey was carried out and 

images were taken by drone (for photogrammetry 3D modelling) for a specific blast, 

before and after. The collected data were processed by both ways and 3D mesh were 

created and through that volumes were calculated with the use of AutoCAD, Bentley, 

and Pix4D. Sample rocks collected at the site and specific gravity was measured for the 

actual volume modification. Used explosives [amount, type], Time consumption for 

volume estimation, Cost effectiveness were analyzed with the results. Depleted volume 

estimation through Photogrammetry 3D modelling is less time consuming than the total 

station method. For the nationwide purpose photogrammetry 3D modelling is most 

suitable with best practices.  

 

KEY WORDS: Total station, Photogrammetry, GSMB 
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1 INTRODUCTION 

1.1 Research Topic 

Study on Royalty for Industrial Minerals and Building Materials in Sri Lankan Mining 

1.2 Background 

Mining activities creates wealth and economic surpluses. Many state and private 

companies are engaged in the exploration, development and mining of mineral deposits. 

Royalty is a payment made to the owner of mineral rights for the privilege of extracting 

the mineral from the ground based on a lease agreement. In other words, it is a payment 

made to the Government to compensate for the extraction/ depletion of a resource 

owned by the state. Currently, there are about 1700 quarries operating in Sri Lanka 

producing industrial minerals. 

The global royalty taxation systems are different from one country to another. They can 

be mainly classified into three types, namely unit based, value based (ad valorem) and 

profit based. Unit based or tonnage basis is mostly applied to high volume, low-value 

homogenous minerals. It is the mostly applied method in the world (Andewal K., 2014). 

The ad valorem based system needs the knowledge of mineral value. Those two 

methods are mainly used in developing countries, with some countries used to combine 

two or three methods and form a hybrid system to calculate royalty. The profit based 

royalty system is common in developed countries.  

1.3 Problem Statement 

Sri Lankan royalty system can be considered as a combination of unit based and value 

based system and this depends on the commodity. Currently, the Royalty levy for 

industrial minerals is calculated by an equation based on the amount of explosives used. 

Detailed study conducted by the Geological Survey and Mines Bureau (GSMB) has 

revealed that in some cases the total tonnage calculated from the equation, drastically 

differs from the true value. As royalty levy on minerals is part of the government 

revenue, any errors in the calculation is not admissible. 
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The explosive-based method adopted by the GSMB, an indirect method for the 

calculation of royalty levy in the absence of an accurate, reliable method for the 

calculation of production is as follows; 

𝑻 =  𝟐 ×  (𝒂 +  𝒃)  +  𝒄 

T – Excavated quantity in Cubes 

a – Amount of Water Gel used in kg 

b – Amount of ANFO (Ammonium Nitrate + Fuel Oil) used in kg 

c – Amount of Black Powder used in kg 

The excavated quantity is solely based on amount of explosives used and the margin of 

error is too high and may result in a tremendous amount of loss of revenue the country. 

The error originates from the fact that the depletion of the ore depends on the degree of 

fragmentation of the rock. Therefore, this explosive based system not suitable to 

estimate the depletion of a blasted rock. 

The royalty is being made with an explosive based volume calculation equation in Sri 

Lanka by GSMB. The volume calculated through is having unavoidable error margins. 

As a government organization, the GSMB needed to solve this situation and to make a 

practical solution which can be adaptable to Sri Lankan situations. Several test blast 

reports from several sites were analyzed and a graph was plotted to analyze the 

deviation of GSMB Volume from the Expected Theoretical Volume. 
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The horizontal axis is showing licensee companies and the vertical axis is showing the 

Percentage Deviation between Expected Volume & GSMB Volume. Commonly every 

test blast reports have accountable deviation. Especially China CAMC Engineering Co. 

Ltd having the largest deviation that is 73.08 %. It has happened because their borehole 

diameter is larger (110 mm). the larger BH Diameter having a large deviation in volume 

calculation. As per the graph, it is clearly visible that errors occurring by the current 

methodology of volume calculation are very large. 

Indirect methods are not practicable in Sri Lankan conditions due to the trustworthy 

between GSMB and licensee is very poor. The research is carried out to provide a better 

solution to overcome this volume estimation error. The solution should be conditions 

and also lesser time consuming, economically efficient and most importantly it should 

be adaptable to Sri Lankan 

 

 

Figure 1-1: Deviation of GSMB Volume 
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1.4 Significance of the Research 

Country’s mineral potential should be exploited in an optimum manner which will 

generate maximum benefit to the national economy. 

This is a highly important study as this directly affects to the finance body of the 

country. And based on our suggestions royalty calculation system of Sri Lanka might 

change totally. Therefore, this research can be a turning point in mining industry of our 

country and will highly contribute to the national economy.   

1.5 Aims & Objectives 

• Main objective of the research is to propose an accurate and practical method to 

evaluate the excavated quantity of the mineral during the time period specified 

by the regulatory body. 

• Introducing a simple-to-Implement methodology of implementation using the 

state-of-the-art methodology of measurement, calculation and collecting the 

levy 

• Raise the awareness among licensees how the mining royalty is calculated 
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2 LITERATURE REVIEW 

2.1 Introduction  

Royalty is a payment made by the licensee to another that owns the particular asset. 

The royalty is generally progressed with a percentage of revenue or fixed price per unit 

of an asset. World widely this royalty payments were made by various methodologies. 

Basically there are 03 basic methods; 

• Unit based (Tonnage based) 

Assessed on the quantity of mineral produced, mostly applied to high volume, 

low value homogenous minerals 

• Value based (Ad valorem) 

These royalties are imposed on the market value of the mineral produced 

without regard to the costs incurred by the miner 

• Profit based 

It is a rate assessed on the profit of the operation  

This literature review is mainly focused on royalty systems in Asian, African and 

Australian continents which are highly concentrated with mining industries. 

Furthermore volume estimation via photogrammetric 3D modelling is also discussed 

here. 

2.2 Sri Lankan Royalty System 

2.2.1 Overview 

Sri Lankan royalty system can be considered as a combination of unit based and value-

based system, and this depends on the commodity. Royalty for industrial minerals are 

calculated by an equation based on the number of explosives used. Following four 

categories are used in Sri Lanka when deciding the royalty for a particular mineral; 
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Explosive basis method is used mainly for Aggregates in A, B and C Grade Quarries. 

It doesn’t depend on whether it a single-hole blast or a multiple-hole blast. This method 

is explained in detail in the problem statement. 

For non-exporting industrial minerals such as Calcite, Mica, Feldspar, Limestone and 

Kaolin royalty is determined based on the factory letter. GSMB have come to an 

agreement with them regarding the royalty and those factories will issue a letter 

mentioning how much of material is extracted each month or quarter. Based on this 

letter royalty will be calculated. In most cases these factories have their own weighing 

bridges.  

In the Palavi Processing Plant of Siam City Cement (Lanka) Ltd, they have occupied 

the following method to calculate the daily limestone dispatch from the quarry. Royalty 

for limestone will be calculated based on this amount. When the train arrives at the 

plant, first two wagons will be uncoupled from the rest and a shunting locomotive will 

haul these two wagons to the weighing bridge. The weight of an empty wagon is 

9500kg. 

Total material weight is calculated as follows; (n - Number of wagons) 

Total Amount of Limestone = (
weight of 2 wagons 

2
− 9500 kg)  × n 

Category Commodity Remarks 

Explosive Basis  Mostly for Aggregates  For both Single-hole, 

Multiple-hole blasts 

Based on the factory 

letter  

Non-Exporting-Industrial Minerals 

Ex: Calcite, Mica, Feldspar, 

Limestone, Kaolin 

Royalty value depends on 

the industry 

Custom Declaration Exporting – Industrial Minerals 

Ex: Graphite, Quartz, Ilmanite, 

Rutile, Zircon, Dimension stones 

Amount declared by custom 

is considered to calculate 

royalty 

Based on License 

Agreement 

Sand, Gravel, Soil Maximum allowed monthly 

production 

Table 2-1: Sri Lankan Royalty System 
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This process will be repeated for other train trips as mentioned above. Finally, the 

amount of limestone arrived at plant will be calculated daily. This weight is used for 

royalty calculations. Furthermore, this is a unit-based royalty system. 

3rd Category of calculating royalty is based on the custom declaration. When we export 

a mineral, all the materials will be properly checked and quantified by the custom. So 

that no one can provide false data. This will be the best method to calculate the royalty 

although it is time consuming. Royalty for exporting industrial minerals (Graphite, 

Quartz, Ilmanite, Rutile, Zircon, Dimension stones etc.) are calculated from above 

method. 

 In the final category, royalty will be calculated based on the license agreement. 

Maximum amount allowed for each mineral per month is considered as the amount that 

they have extracted within a month. And the royalty will be calculated based on this 

amount. For Sand, Gravel and Soil royalty will be calculated under this category. 

2.2.2 Royalty rates in Sri Lanka 

Royalty rates of some minerals in Sri Lanka based on market value of the mineral 

produced are shown below; 

 

 

 

 

 

Sri Lanka, 2005, 1992 No. 33 Mines and Mineral Act 

 

 

Table 2-2: Royalty Rates in Sri Lanka 

Commodity Royalty rate 

Valuable Metal 4% 

Industrial Minerals (non-Exporting) 3% 

Industrial Minerals (Exporting) 4% 

Building Materials 1% 

Aggregate (Exporting) 4% 

Other Metals 3% 
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2.3 Indian Royalty Regime 

Before 2009, India has used two methods to calculate mining royalty as alternatives. 

They are given below; 

(1) Tonnage based 

(2) Ad-valorem based  

Before 2009, nine minerals (Chrysotile Asbestos, Dolomite, Limestone, Lime Kantar, 

Lime Shell, Monazite, Ochre, Slate and Tungsten) covered tonnage based and 

remaining minerals covered ad-valorem based. But in 2009 HODA Committee 

submitted report to government. After the HODA committee submission, some royalty 

system features of India is changed as given below;   

✓ Royalty rates for minerals (Amphibole Asbestos, China Clay/Kaolin (including 

Ball Clay, White Shale and White Clay), Graphite, Iron ore, Quartz, Silica sand, 

Moulding sand and Quartzite) to be shifted from tonnage basis system of royalty 

to ad valorem basis. 

✓ Royalty rates for 9 minerals (Chrysotile Asbestos, Dolomite, Limestone, Lime 

Kankar, Lime shell, Monazite, Ochre, Slate and Tungsten) has been continued 

to attract unit of production based royalty, because it was held that shifting over 

to ad valorem rates for these minerals is not administratively feasible 

✓ For the base metals (Copper, Zinc, Lead) rates of royalty has been continued to 

be linked to the international benchmark metal prices  

Below table contains main mineral royalty rates in India in 2009; 
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2.4 Royalty Systems in South Africa 

In South Africa three royalties have been used so far and the best method is Ad-

valorem/ Sales royalty. Those royalty methods are listed below. 

✓ Production/ Unit royalty - Assessed on the quantity (i.e. ounces or tons) of 

mineral produced, and the value is independent of the commodity price 

✓ Profit-based royalty - Profit-based royalty is a rate assessed on the profit of the 

operation.  

✓ Ad-valorem/ Sales royalty - The last kind of royalty is assessed on the market 

value of the mineral produced, and unlike the first kind, it is highly dependent 

on the relevant commodity   price. This is the most common royalty used in 

Africa 

Royalty method of Ad-valorem percentage calculating formula is given below as 

Finance Management in south Africa, Act, 1999 (Act No 1 of 1999), the formula 

presently applicable in section 4(2) is as follows; 

 

Royalty percentage = 0.5 +  
(earnings before interest and taxes)

(gross sales in respect of unrefined mineral resources x 9)
x100 

Table 2-3: Mineral Royalty Rates in India 
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In terms of section 4(3) (b), the percentage determined in terms of the formula must not 

exceed 7%. 

Below table includes royalty rates of different countries for Base Metals and Precious 

Metals; 

 

 

 

 

 

 

 

 

 

 

2.5 Australian Royalty System 

2.5.1 New South Wales 

A mineral royalty is an amount charged by the country for the transfer of the privilege 

to extract a mineral resource. There are mainly three type of royalty system has been 

occupied in Western Australia. Such as coal royalties, mineral (non-coal) royalties and 

petroleum royalties. Mineral royalty can be divided into two main groups and the 

royalty rates are recommended under the Mining Act 1992 in NSW. 

 

 

 

Table 2-4: Royalty Rates in Different Countries 

https://www.legislation.nsw.gov.au/#/view/act/1992/29
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Figure 2-1: Royalty Calculation Method in NSW 

• Quantum Royalty (unit based) 

The royalty system based on the unit of production basis and generally applied 

for the low volume of minerals such as gypsum limestone, and clays. 

• Ad-valorem Royalty (value based) 

The royalty system generally applied for high volume minerals. That system 

based on 4% rate of the ex-mine value of minerals. Ex-mine value is the value 

of the mineral once it is mined and brought to the surface. Sometimes the 

expenses related to the processing it may be allowable deductions. And also, 

costs associated with the exploration, development, and rehabilitation of the site 

are not considered as allowable deductions. 
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2.5.2 Western Australia 

Royalties prescribed under the Mining Act 1904 and Mining Act 1978, as well as under 

state agreements. In Western Australia, two main type of royalty system has been used. 

There are Specific Rate Royalty and Ad-valorem Royalty. In some cases, they have used 

a Netback Royalty system. 

Specific Rate Royalty system applies to the low value of materials such as clay, gypsum, 

and sand, also apply to some industrial minerals, such as salt and talc. Royalty is 

calculated by applying a rate to each ton produced. For an example, the rates of 62 cents 

and $1.00 per ton apply in Western Australia. 

Ad-valorem Royalties apply to metallic minerals and generally higher value industrial 

minerals. The royalty is calculated as a percentage of sale value or metal value. There 

are three ad valorem rates, which can be used in Western Australia. Those are express 

as, 7.5% applies to bulk material, 5% for mineral concentrates and 2.5% for minerals 

in metal. 

Netback royalty system calculated by applying a rate to the value of minerals, when 

they first extracted from the ground. It is based on the mine head value of the owner 

and this system is mainly used in petroleum industry. 

2.6 Photogrammetric 3D Modelling  

‘Photogrammetry’, as its name indicates is a 3-dimensional coordinate assessing 

technique that uses photographs as the major medium for measurement. The ultimate 

principle used by photogrammetry is triangulation or more precisely termed as ‘Aerial 

Triangulation’. By capturing minimum two photographs from two different locations, 

the line of sight can be developed from each camera to points on the object. These lines 

of sight commonly termed rays are precisely intersected to produce the 3-dimensional 

coordinates of the points of interest. 
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In a very simple manner photogrammetry involves the inverse practice of photography. 

In photography, a camera projecting the 3D world into a 2D plane (image negative). In 

photogrammetry, multiple photos which represents the object from various lines of 

sight are used to reproduce the 3D world it was originally projected from. 

 

 

 

 

 

 

 

 

2.6.1 Techniques and Methodologies 

The generation of 3D models based on the actuality of large and complex sites or 

structures is currently carried out using passive sensor and image data methodologies, 

active optical sensors, and image data. Distance, conventional surveys (e.g. total 

stations or GNSS) or integration of the above techniques. For architectural engineering 

and the construction industry, 3D geometric models can also be created from existing 

2D drawings or maps, interactively and using extrusion functions. The choice or 

integration depends on the accuracy required, the dimensions of the site and the object, 

the constraints of the location, the portability and the user-friendliness of the 

instrument, the characteristics of the surface, experience of the work team, project 

budget, end goal etc. 

Active optical sensors, such as laser scanners (pulsed, phase shift or triangulation 

instruments) and tape projection systems, have received a lot of attention in recent years 

for 3D documentation and modeling applications.  

Figure 2-2: Concept of Photogrammetry 
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They directly provide ranges (for example, distances and thus 3D information in the 

form of unstructured point clouds) and become quite general in the heritage field, 

despite their high costs, weight and usual lack of texture satisfactory. For surveying, 

the instrument should be placed in different places where the object is moved so that 

the instrument can see it from different points of view. Successively, raw data requires 

the removal of errors and outliers, noise reduction and sometimes the filling of holes 

before alignment or registration in a single reference system to produce a single point 

cloud of the scene or object studied. Recording is usually done in two steps: 

1) Manual or automatic gross alignment using targets or data 

2) Final global alignment based on the closest point method procedures. Or least 

squares.  

After global alignment, redundant points must be removed before a surface model is 

produced and textured. 

The scanning results are a function of: 

• Intrinsic features of the instrument (calibration, measurement principle, etc.) 

• Features of the scanned material in terms of reflection, light diffusion, and 

absorption (amplitude response) 

• Features of the working environment 

• Coherence of the backscattered light (phase randomization) 

• Dependence from the chromatic content of the scanned material (frequency 

response) 

Terrestrial range sensors operate from very short range (a few centimeters) to a few 

kilometers, according to surface properties and environmental characteristics, 

providing 3D data with positioning accuracy ranging from a few hundred microns to a 

few millimeters. Distance sensors, associated with GNSS / INS sensors, can also be 

used on aerial platforms in general for DTM / DSM generation, city modeling and 

archaeological applications. While conscious of the potential of the image approach and 

its latest improvements in automated and dense image matching, the ease of use and 

reliability of active optical sensors for point cloud acquisition amorphous and dense are 

usually much higher.  
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This fact has made active sensors such as laser scanners a very common 3D recording 

solution, especially for non-trained users. Active sensors regularly also include radar 

instruments, which are not generally seen as optical sensors. However, they are 

frequently used in 3D documentation or environmental mapping of cultural heritage. 

Under other conditions, image data requires mathematical formulation to transform 

two-dimensional image measurements into three-dimensional coordinates. Image-

based modeling techniques (mainly photogrammetry and computer vision) are 

commonly chosen in the case of lost objects, monuments or architectures with regular 

geometric shapes, low budget projects, good experience of the work team or time or 

place limitations for the data acquisition and treatment. In addition, the images have all 

the information needed to acquire the 3D shape of the scene studied as well as its 

graphic aspect (texture). Image-based 3D modeling usually requires user interface at 

various stages of the modeling pipeline to obtain exact results, its use being kept for 

experts, while fast 3D results are primarily useful for simple visualization. Commonly, 

minimum two images are required to derive 3D information from the corresponding 

image points, but there are also some ways for developing 3D data from a single image. 

2.6.2 Steps in generation of a 3D model using photogrammetry 

2.6.2.1 Data acquisition 

This can be any type of camera with geo-referencing if the final output is to be measured 

in metric units. Even a camera without geo-referencing option can be coupled to a 

GNSS receiver to collect geo located images. Thus, even smart phones with the 

availability of GPS location are a viable option for data acquisition. 

With the evolving improvement of drones as a remote sensing platform, 

photogrammetry has also made great steps in eliminating the biggest problem of 

photogrammetric data acquisition, namely the collection of data at higher altitudes. This 

has expanded the ability of photogrammetry to be used in larger scale objects, such as 

open pit modeling, which was originally limited to a smaller object, such as a car, a 

statue or a man. 

 



16 

 

2.6.2.2 Data processing 

After the data acquisition, the collected data is processed using computer vision 

algorithms for aero-triangulation, point cloud generation and finally the 3D mesh 

generation. This 3D mesh can then be used for linear measurements (length, height, 

width, etc.), area measurement and volume measurement. 

2.6.2.3 Calculating depleted rock volume using Pix4D and OpenDroneMap 

2.6.2.3.1 Pix4D Mapper 

Pix4Dmapper spontaneously transforms images taken by drone, by hand or by plane 

and provides 2D maps and very accurate and geo-referenced 3D models. They are 

customizable, timely and complete a wide range of applications and software. This can 

be used to calculate the volume difference of a studied area at two points in time. The 

images of each flight must be processed in a separate project, in which the volume of 

the area at that moment is calculated. Then, the results of these calculations can be used 

to calculate the difference in volume of a zone. 

. 

 

Figure 2-3: Pix4D Process 

CUT BEFORE CUT AFTER 

Figure 2-4: Depletion of the Volume 
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Figure 2-6: Volume Calculation using Open Drone Map 

Volume Difference = Cut After - Cut Before. 

If the volume difference has a negative value, then material has extracted. 

 

2.6.2.3.2 Open Drone Map 

The volume calculations between the base-plane and the terrain surface of your area of 

interest is given in terms of the volume that would need to be removed (in the case of a 

stockpile) and/or added (in the case of a hole) in order to flatten the surface so that it's 

the same as the surrounding ground. 

 

 

 

 

 

 

 

 

 

 

Figure 2-5: Volume Calculation 



18 

 

2.6.3 Significance of Photogrammetric 3D modelling 

In most practical applications, the making of digital 3D models of quarries or sites for 

documentation and preservation requires a technique or methodology that has the 

following properties: 

✓ Accuracy: precision and reliability are two vital aspects of the surveying work 

and final 3D outcomes, if not the work is done for simple and quick visualization 

✓ Portability: the technique must be as portable as promising due to accessibility 

problems, absence of electricity, location constraints, etc. 

✓ Low cost: generally surveying projects have limited budget to perform and 

expensive documentation and instruments will cost more than the budget  

✓ Fast acquisition:  most of the sites or quarries allow a limited fly time for the 

drone` and documentation not to disturb restoration works or the visitors; 

✓ Flexibility: due to the great diversity and dimensions of sites and objects, the 

technique should allow different scales and it should be applicable in any 

possible condition. 

All these are often not applicable to a specific procedure. As a result, most survey 

projects related to large and complex sites (Quarries) integrate and combine multiple 

sensors and techniques. However, the image-based approach has different advantages 

over the beach-based approach and is often chosen although it sometimes necessitates 

user interaction and some knowledge with acquisition and data processing. 

2.7 Multicopter UAV and Total Station for Estimating Stockpile Volumes 

There are several UAV systems on the market place today for commercial applications, 

including multicopter or multi-engine UAVs. Their main benefit is ease of use, 

flexibility and stability. The modern prototypes offer a load of up to 5 kg and can contain 

complex and heavy surveying systems, such as single-lens reflex cameras. The 

commonly used multicopters have at least four rotors, i.e. a quadricopter, but may have 

a hexacopter or an octocopter for redundancy purposes. 
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2.7.1 UAV Photogrammetry 

The use of UAV Photogrammetry gives a real time application and low-cost 

substitutions to the manually driven aerial photogrammetry. The pixel value of 

multicopter UAV can be less than 5cm x 5cm (at altitude level of 20-30m). Through 

this 3D model or DSM can be generated. For the data acquisition purpose DJI phantoms 

can be used here. 

2.7.2 Volume Estimation 

To obtain stock volume values, initially images has to be adjusted with GCP. These 

points were the same geo-referenced points (with GNSS) around the stock that has been 

use to organize the TST. Then the Pix4D software to estimate the volume. Initially a 

stockpile object should be drawn then the tie points of the stockpile base has to be 

changed to 3D GCPs. The altitude of the 3D GCPs has to be changed to the desired 

altitude of the volume base. And for the new volume calculation raycloud should be 

opened and stockpile object must be selected.  

 

 

 

 

 

Figure 2-8: UAV Point Cloud with 

stockpile drawing top view 
Figure 2-7: UAV Point Cloud with stockpile 3D view 
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2.8 Conclusion  

All of these above methodologies are based on royalty systems which are followed in 

many countries worldwide. As was mentioned in previous sections, Sri Lankan system 

is an explosive based royalty calculation method with a high error. It is not practical to 

practice ad-valorem or tonnage based methods in Sri Lanka with the existing 

technologies due to the impracticality of obtaining accurate basic information and lack 

of a reliable monitoring and tracking system. Therefore, in this research, in the 

methodological approach presented below in the form of a flow-chart, adoption of 3-D 

modeling I shown conducting relevant field studies. 
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3 METHODOLOGY 

3.1 Area of Study 

”A Grade” metal-quarry located approximately 25km away from the Kalutara has 

been selected. The site surveyed was approximately 5km2 of area with vegetation, 

steep and rough faces as well as a typical open quarry environment. The site chosen is 

a 25 m section of the quarry site. The site was selected to evaluate the suitability of 

the UAV for calculation of rock volumes. The main objective of the survey is to 

estimate the volume of in situ rock. Surveying is a necessary activity to determine the 

elevations, distances, and angles for a specific area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3-1: Location of the Quarry Site 
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3.2 Weighing the Blasted Rock Tonnage 

3.2.1 Overview 

This can be considered as one of the most accurate methods in determining the depletion 

of a rock. The issue with this method is we must need a weighing bridge to measure the 

tonnage. It’s not practical to have a weighing bridge for each and every quarry in Sri 

Lanka. However, this method will provide an accurate value for the blasted volume 

than other methods as we are directly measuring the tonnage.  

3.2.2 Swell factor  

One cubic meter of earth material measured in the natural position (in situ) swells to 

more than one cubic meter after it is excavated. The swell factor used to calculate the 

volume increase. Because it is void spaces increase. It is can be expressed as a 

percentage to the natural volume.  

𝑆𝑤𝑒𝑙𝑙 𝐹𝑎𝑐𝑡𝑜𝑟 =  𝐿𝑜𝑜𝑠𝑒 𝑜𝑟 𝐵𝑢𝑙𝑘 𝑉𝑜𝑙𝑢𝑚𝑒
𝐼𝑛𝑠𝑖𝑡𝑢 𝑉𝑜𝑙𝑢𝑚𝑒⁄  

Our surveyed rock is Charnockite which swells factor normally calculated as the value 

of 75-80%. However mass of the rock will not change in bulk form. 

3.2.3 Calculation of the depleted volume 

Here are the steps to calculate the depleted volume using blasted tonnage; 

𝑇𝑜𝑡𝑎𝑙 𝑇𝑜𝑛𝑛𝑎𝑔𝑒 𝐻𝑎𝑢𝑙𝑒𝑑

= 𝑇𝑜𝑡𝑎𝑙 𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝐿𝑜𝑎𝑑𝑠 × 𝐴𝑣𝑒𝑟𝑎𝑔𝑒 𝑇𝑜𝑛𝑛𝑎𝑔𝑒 𝑝𝑒𝑟 𝐿𝑜𝑎𝑑  

𝐼𝑛𝑠𝑖𝑡𝑢 𝑉𝑜𝑙𝑢𝑚𝑒 =  𝐼𝑛𝑠𝑖𝑡𝑢 𝑀𝑎𝑠𝑠
𝐼𝑛𝑠𝑖𝑡𝑢 𝐷𝑒𝑛𝑠𝑖𝑡𝑦⁄  

However in most cases, In-situ Mass = Bulk Mass = Total Tonnage Hauled. Therefore; 

𝐼𝑛𝑠𝑖𝑡𝑢 𝑉𝑜𝑙𝑢𝑚𝑒 𝑜𝑟 𝐵𝑙𝑎𝑠𝑡𝑒𝑑 𝑉𝑜𝑙𝑢𝑚𝑒 =  
𝑇𝑜𝑡𝑎𝑙 𝑇𝑜𝑛𝑛𝑎𝑔𝑒 𝐻𝑎𝑢𝑙𝑒𝑑

𝑆𝑝𝑒𝑐𝑖𝑓𝑖𝑐 𝐺𝑟𝑎𝑣𝑖𝑡𝑦⁄  
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Figure 3-2: Determination of Specific Gravity 

3.2.4 Determination of specific gravity of the rock  

Specific gravity was calculated on site with a simple experiment; 

 

 

 

 

 

 

 

 

 

 

 

1) Approximate 1kg of in-situ rock sample was obtained and weight of the rock 

piece in the air was measured using electronic balance. (W1 = 1.115kg) 

2) Water was filled to 3/4 volume of the beaker and a small hole was created just 

above that level so that excess water would flow outside. 

3) Then the rock piece was put into the beaker.  

4) Weight of the outflowing water was recorded. (W2 = 0.410kg )  

5) Finally specific gravity of the rock was calculated as below; (g = 9.81ms-1) 

 𝑆𝑝𝑒𝑐𝑖𝑓𝑖𝑐 𝐺𝑟𝑎𝑣𝑖𝑡𝑦

=  
𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑡ℎ𝑒 𝑠𝑢𝑏𝑠𝑡𝑎𝑛𝑐𝑒

𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑡ℎ𝑒 𝑒𝑞𝑢𝑎𝑙 𝑣𝑜𝑙𝑢𝑚𝑒 𝑜𝑓 𝑤𝑎𝑡𝑒𝑟⁄

=  
1.115𝑔

0.410𝑔⁄ =  2.7195 

Wimal Quarry administration have measured the specific gravity of the rock (in a 

laboratory) in 2016 and that was 2.737 which is really close to our value. As we 

measured this value on site, we decided to use their value as the correct specific gravity 

for our calculations. 
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3.3 Total Station Survey at Metal Mix Quarry Site 

3.3.1 Overview 

Total station can determine the coordinate of an unknown point relative to the known 

coordinate. Using the trigonometry and triangulation, 3D coordinate of the point was 

measured is determined. Survey data was downloaded to the computer for the 

processing purposes and we have generated 3D model by using AutoCAD software. 

The accuracy of the coordinate is for mm level. But when the survey area becomes large 

it can result in some issues of accuracy. As most of Sri Lankan quarries do not have a 

proper bench system. Although A Grade quarries have some benches, B and C Grade 

quarries doesn’t have a proper bench system. 

3.3.2 Specification of the total station 

Brand: Leica flex line Ts02/Ts06/Ts09 

Description  Specification 

1” Angular accuracy enhanced the 

measurement accuracy to prism 

2mm+2ppm 

Reflectors measurement range 500m option 

Display with graphics and display 

illumination 

Black and White high resolution 

 

3.3.3 Distance measurement 

First step of the total station survey was find a suitable location (spot) one processing 

sight lines to all major point and solid ground. Total station generated laser that 

reflected by a prism reflector. Modulation pattern in the returning signal is read and 

interpreted by the computer in the total station. The distance is determined by emitting 

and receiving multiple frequencies and wave length.   

The distance measured is always sloping direction from instrument to the object. The 

accuracy of measurement varies from 5mm to 10mm per km measurement. 
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3.3.4 Angle Measurement  

When taking the horizontal angle, we can get measurement to any convenient direction 

as reference direction. In our case we have taken measurement with respect to the north 

direction. Angle measurement accuracy varies from 2 to 6 seconds. 

3.3.5 Measuring pre-blast and post blast faces 

3.3.5.1 Pre-blast rock face 

Before the blast, location of the TS was entered as the base point. Then the TS was 

tilted to the reference direction (north in our case) and angular measurement was set to 

zero and get a reference coordinate for the instrument location. Then many points were 

taken from the upper and lower surfaces of the pre-blast face in non-prism mode. 

3.3.5.2 Post blast rock face 

After the blast, surrounding area near the rock face was cleared. Then we have taken 

several readings from top and bottom surfaces of the post blast face using both prism 

and non-prism modes. 
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3.4 Drone Image Processing using Agisoft PhotoScan 

Following steps are followed in order to get a product using Agisoft PhotoScan; 

1) Loading photos 

2) Aligning photos 

3) Building Dense Point Cloud 

4) Building Mesh 

5) Building Model Texture 

6) Building Tiled Model 

7) Building Digital Elevation Model (DEM) 

8) Building Orthomosaic 

Here are the steps to carry out a volume calculation using Agisoft PhotoScan; 

3.4.1 Loading photos 

To load a set of photos 

Select Workflow menu → Add Photos or click Add Photos toolbar button on the 

Workspace pane. 

Then select the photos or photo directory and click Open button. Selected photos will 

appear on the Workspace pane. 

3.4.2 Aligning photos 

In this step all photos are aligned and properly oriented. Software builds a Sparse 

Point Cloud after finding the camera position and orientation of each photo. 

Select Workflow menu → Align Photos 

Here we have used the Medium Accuracy settings for most of our models as High 

Accuracy settings are time consuming. Anyway we can reduce the processing time by 

utilizing Pair Selection option.  
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3.4.3 Building Dense Point Cloud 

Program combines depth information which have been obtained from all the cameras 

to a single Dense Point Cloud. We can adjust the position of reconstruction volume 

bonding box depending on our region of interest. 

Select Workflow menu → Build Dense Cloud 

Like in the aligning step we selected Medium Quality as it consumes less time, but it 

is better to select High Quality for more detailed and accurate geometry.  

In the Depth Filtering Modes, we have to select different modes based on our 

requirement; 

• Mild – If there are small details (which can be spatially distinguished) that we 

need to reconstruct. 

• Aggressive -  If area doesn’t contain any meaningful small details 

• Moderate – To get intermediate results 

• Disabled – This mode is not recommended 

 

Figure 3-3: Sparse Point Cloud 
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3.4.4 Building Mesh 

Mesh is a collection of vertices, edges and faces that defines the shape of an object or 

a model. Here we have selected Dense Point Cloud as the source for the Mesh. 

Select Workflow menu → Build Mesh 

3.4.5 Building Model Texture 

Even though we get considerable appearance after generating 3D Model, we will get 

better appearance for the model after building Model Texture. 

Select Workflow menu → Build Texture 

3.4.6 Building Tiled Model 

This is an additional feature for our project. We can obtain large area 3D models in 

high resolution using this option. 

Select Workflow menu → Build Tiled Model 

Figure 3-4: Dense Point Cloud 



29 

 

Figure 3-5: DEM (Contours at 0.5m Intervals) 

 

3.4.7 Building Digital Elevation Model (DEM) 

This is one of the most important steps in calculating the volume of a feature using 

Agisoft PhotoScan. To calculate the volumes in Agisoft, we can use only the DEM 

(Digital elevation Model) or the Orthomosaic.  

Select Workflow menu → Build DEM 

 

 

 

 

 

 

 

 

 

 

 

3.4.8 Building Orthomosaic 

The orthomosaic or the orthophoto is the best source to calculate true length, area and 

volume information. What we get from an aerial photograph is not an accurate 

representation of the earth’s surface. In orthomosaic errors due to topographic relief, 

lens distortion and camera tilt are adjusted. 

Select Workflow menu → Build Orthomosaic 
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An orthophoto or orthomosaic is an aerial photograph geometrically amended such 

that the scale is uniform, the photo has the same lack of distortion as a map. Unlike an 

uncorrected aerial photograph, an orthophotograph can be used to measure true 

distances, because it is a precise representation of the earth’s surface, having been 

adjusted for topographic relief, lens distortion, and camera tilt. 

Finally we have obtained following outputs using Agisoft PhotoScan software; 

1) Pre Blast Face – Medium Quality 

2) Pre Blast Full Quarry – Medium Quality 

3) Post Blast Face – Medium Quality 

4) Post Blast Full Quarry – Medium Quality 

5) Post Blast Face – High Quality 

 

 

 

Figure 3-6: Orthomosaic or Orthophoto 
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Figure 3-7: After Adding Photos to the Block 

3.5 Drone Image Processing using Bentley ContextCapture 

Bentley ContextCapture is another 3D mesh generating software which has better 

capabilities than other softwares. Speciality with ContextCapture is we don’t need build 

an orthomosaic or a DEM to do volume calculations. We can do it using the 3D Mesh. 

Procedure for generating a 3D Mesh using Bentley ContextCapture is as follows.  

First we have created a project;  

Project → New Project 

Now we can create any number of blocks under this project. For an example one block 

for pre-blast and another block for post blast etc. So we have added a block. 

Block → New Block 

After creating a block next step is to add the photos, the Add Photos button was clicked. 

Photos → Add Photos 

After uploading photos to the ContextCapture if there are any incomplete photos, we 

can estimate the missing information by Aerotriangulation. In the General tab we can 

find the Submit Aerotriangulation button. 

General → Submit Aerotriangulation 
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Figure 3-8: Submitting New Reconstruction 

Next comes the Reconstruction step; we have divided the model into Tiles, otherwise it 

will take a higher time to generate the 3D mesh and sometimes software will ask for 

higher RAM capacity. Under the Spatial framework tab we have changed the tiling 

option to Regular planar grid in most cases. So that software will decide how many 

tiles that are needed to generate the 3D Mesh. And we have used the Medium Precession 

setting for reconstruction due to the limited time. 

General → New reconstruction 

 

 

 

 

 

 

 

 

 

 

 

Next comes the most important step in 3D Mesh generation, which is submitting the 

new production. Importance in Bentley ContextCapture is we don’t need build dense 

cloud and generate mesh, we can directly generate the 3D Mesh. Also we can 

incorporate this 3D Mesh for volume calculation work. 

General → Submit new production 
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3.6 Drone Deploy Volume Calculation  

3.6.1 Overview 

Volume estimation with DroneDeploy is a fast, accurate and practical to calculate the 

volumes on the maps from any device. DroneDeploy mainly used in mining industry 

various cases such as site survey and inspection, to equipment tracking and 

fragmentation analysis. DroneDeploy's volume estimations are accuracy level 1-2%. 

We did all data analysis using the 14-day trial of Drone Deploy Pro online version. 

Trial limited to 10 maps and models. The DroneDeploy software app automates the 

flight path of the drone and capture the aerial images. The DroneDeploy software 

platform used to processes the UAV images using the computer version. After that we 

can get 2D, 3D maps and models. 

3.6.2 Measuring the volume using pre-blast and post blast models 

  

 

 

 

 

 

 

 

 

Post Blast volume measurement by using Drone deploy software; 

1) First need to select an area for which to compute the volume in the model 

2) The Volume icon from the Annotation & Measurement space was chosen 

 

 

 

Figure 3-9: 3D Model of the Pre-Blast Quarry 
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Figure 3-10: Post Blast 3D Model 

Figure 3-11: Drawing the Polygon around the Rock Pile 

 

 

3) The points were added around the rock pile to mark the polygon which we 

wanted to compute the volume 
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4 RESULTS & INTERPRETATIONS 

4.1 Volume Measurement by Weighing the Blasted Tonnage  

• Total Number of Loads = 75 

• Average Tonnage per Load = 10.212 tonnes 

• Specific Gravity of In-situ Rock = 2.737 

𝑇𝑜𝑡𝑎𝑙 𝑇𝑜𝑛𝑛𝑎𝑔𝑒 𝐻𝑎𝑢𝑙𝑒𝑑

= 𝑇𝑜𝑡𝑎𝑙 𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝐿𝑜𝑎𝑑𝑠 × 𝐴𝑣𝑒𝑟𝑎𝑔𝑒 𝑇𝑜𝑛𝑛𝑎𝑔𝑒 𝑝𝑒𝑟 𝐿𝑜𝑎𝑑

=  75 × 10.212 = 765.9 𝑡𝑜𝑛𝑛𝑒𝑠 

𝐼𝑛𝑠𝑖𝑡𝑢 𝑉𝑜𝑙𝑢𝑚𝑒 𝑜𝑟 𝐵𝑙𝑎𝑠𝑡𝑒𝑑 𝑉𝑜𝑙𝑢𝑚𝑒 =

 
𝑇𝑜𝑡𝑎𝑙 𝑇𝑜𝑛𝑛𝑎𝑔𝑒 𝐻𝑎𝑢𝑙𝑒𝑑

𝑆𝑝𝑒𝑐𝑖𝑓𝑖𝑐 𝐺𝑟𝑎𝑣𝑖𝑡𝑦⁄ =  765.9
2.737⁄  =  279.832 m3 
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4.2 Measuring Rock Depletion using Total Station 

4.2.1 Pre-blast survey data 

Date: 2018.10.05 

Time: 10:11am 

Instrument/ Base Point coordinate: (1000, 1000, 100) 

Instrument height: 1.57m 

Brand: Leica flex line Ts02/Ts06/Ts09 

Table 4-1: Pre-blast Survey Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Point No Easting 

Coordinate(m) 

Northing 

Coordinate(m) 

Height 

(m) 

1 1043.713 1008.106 100.290 

2 1041.604 1007.716 97.015 

3 1039.537 1001.511 100.695 

4 1036.241 1001.385 96.611 

5 1037.560 998.031 100.771 

6 1033.293 998.248 96.797 

7 1033.758 994.126 100.975 

8 1031.116 994.586 96.736 

9 1031.606 991.034 100.603 

10 1029.031 991.764 97.067 

11 1028.656 988.816 100.854 

12 1026.618 989.612 97.908 
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4.2.2 Post blast survey data 

Date: 2018.10.05 

Time: 2:00pm 

Instrument coordinate: (1000, 1000, 100) 

Instrument height: 1.46m 

Brand: Leica flex line Ts02/Ts06/Ts09 

Table 4-2: Post Blast Survey Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Point No Easting 

Coordinate(m) 

Northing 

Coordinate(m) 

Height 

(m) 

1 1043.324 1006.416 100.468 

2 1041.866 1006.199 97.668 

3 1043.236 1002.202 100.624 

4 1042.838 1002.181 97.830 

5 1041.203 999.593 100.069 

6 1034.638 999.818 98.511 

7 1036.947 993.921 100.953 

8 1036.892 993.942 98.312 

9 1034.151 990.140 100.179 

10 1033.548 990.328 97.595 

11 1029.779 987.535 100.809 

12 1026.302 988.990 97.930 

13 1031.603 988.606 100.177 

14 1029.579 989.336 97.507 

15 1042.438 1000.430 100.462 

16 1040.636 1000.412 96.955 

17 1037.187 994.376 100.435 

18 1036.099 994.318 97.134 
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4.2.3 Data processing and generation of the 3D model 

Pre-blast rock face was drawn in AutoCAD, according to the data we obtained before 

the blast. Here we need to shift to 3D view as we are going to generate a solid. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Post blast rock face was drawn based on the data obtained after the blast. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-1: Pre-blast Rock Face 

Figure 4-2: Post Blast Rock Face 
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After importing all the coordinates to AutoCAD, the 3D solid was generated in order 

to find the volume of the blasted rock. The volume that we obtained from AutoCAD 

software was 254.837 m3. 

 

 

 

 

 

 

 

 

 

4.2.4 Advantages and disadvantages of Total Station Survey 

Advantages of Total Station Survey 

• Accuracy is high for point measurements 

• Quick setup of the instrument on the tripod  

• Reliable 

• On board area computation  

• Data can be saved and transference to PC  

• No writing and No recording errors 

Disadvantages of Total Station Survey 

• Time consuming (more than a week to map some quarries) 

• Skilled surveyors are needed 

• Instrument cost is very high 

• Skilled personnel are needed to process the data and it is time consuming 

 

Figure 4-3: Blasted Rock Volume as a Solid 
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Figure 4-4: Post Blast Face 

4.3 Volume Calculation using Agisoft PhotoScan 

4.3.1 Overview 

Here we have calculated the blasted volume of the rock using 2 methods; 

1. Measuring the volume using pre blast and post blast faces 

2. Measuring the volume of the blasted rock pile 

4.3.2 Measuring the volume using pre blast and post blast faces 

First step under this method is to mark the post blast face. For that we need to switch 

into a format or mode where we can draw shapes on top it. In that case, we can use 

Orthophoto or DEM to draw shapes. Also those can be utilized to calculate height, area 

and volume. After double clicking on Orthophoto or DEM, we can enter to this mode. 

In the Agisoft Toolbar, there is an option called Draw polyline, we can draw a polyline 

using that option.  

Toolbar → Draw Polyline 

 

 

 

 

 

 

 

 

 

 

 

It is easy to draw the polyline with the presence of contours as it show the position of 

the steep slope correctly. We can generate contours by right clicking on DEM; 
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Figure 4-5: Blast Area 

Right click on DEM → Generate Contours 

Next step is to export this polyline (post blast face) as a shape file and import it into the 

pre blast model; 

Tools → Export → Export Shapes 

Tools → Import → Import Shapes 

As we didn’t use Ground Control Points (GCPs) when we took aerial photographs, both 

pre blast and post blast models are not properly geo-tagged. Both have shifted from its 

original position slightly. We had to use ArcMap software to bring the shape file into 

its correct relative position. Therefore before importing post blast face shape file into 

the pre blast model, it should be positioned correctly relative to the pre blast model 

using ArcMap. After importing post blast face, we can demarcate the area that we need 

to calculate the volume. For that use the Draw Polygon tool in the Toolbar; 

Toolbar → Draw Polygon 

 

 

 

 

 

 

 

 

 

 

 

Post Blast Face 

Pre Blast Face 
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Figure 4-7: Height Levels of the Polyline 

As the next step, we need to determine base level or bench height of the blast. To fulfill 

that objective we can draw a polyline close to selected area and check the heights/ levels 

along that line. See Figure 4.6; 

Here we have selected the lower most level of this polyline as the base plane of the 

blast: 

 

 

 

 

 

 

 

So the lowest level that we got was -11.3m, so we decided to calculate the volume of 

the blast considering this level. By right clicking on the polygon we can calculate the 

blasted volume as follows; 

-11.3m 

Polyline 

Figure 4-6: Polyline to Check the Ground Height 
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Right Click on Polygon → Measure → Volume 

 

 

 

 

 

 

 

 

 

 

Let’s discuss about each volume that we got from this result; 

• Volume above Best Fit Plane: This is plane is drawn minimizing point-plane 

distance of the base points, in other words sum of the absolute values of 

perpendicular distance from each base point to plane will be minimized. Cut 

volume above this plane will be considered. See figure 

• Volume above Mean Level: Here average base height of the selected area will 

be taken as the mean height/ level. A horizontal plane will be drawn through the 

mean level and this plane is considered as the mean plane. Volume above this 

level will be considered. 

• Volume above Custom Level: Here we can enter a level of our interest and 

calculate the cut volume above that plane.  

As we select an area which lies on two levels (upper and lower surfaces of the blast 

face) we can’t consider volumes above best fit plane or mean plane. So we have to enter 

the base level and calculate the blasted volume. See following Figure 4.9 for better 

understanding; 

 

 

Figure 4-8: Volume Measurement 
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Figure 4-10: Demarcating the Extent of the Blasted Rock Pile 

 

4.3.3 Measuring the Volume of the Blasted Rock Pile 

Here we try to get the volume of the blasted rock pile directly. For that we can draw a 

polygon very close to the blasted rock pile and get the volume of the blasted rock. Here 

we have to ignore rocks which have gone too far away. 

Toolbar → Draw Polygon 

 

 

 

 

 

 

 

 

 

 

We have obtained a high quality post blast model and a medium quality post blast model 

to observe the volume difference. Here we need to consider volume above best fit plane 

as the blasted rock has fallen on top of an inclined plane. Results that we got for those 

both models are shown below; 

Figure 4-9: Different Types of Base Surfaces 
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Although it seems like we get a bulk volume as the volume reading, what we get here 

is an intermediate value between in-situ and bulk volumes. In-situ (in place/ on site) 

density is always higher than the bulk density. Air volume has increased after the 

breakage, therefore the density has reduced in bulk state.  

Figure 4-11: Blasted Volume - Medium Quality Model 

Figure 4-12: Blasted Volume - High Quality Model 
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Figure 4-13: Post Blast 3D Model 

Agisoft PhotoScan software has the ability to identify visible air spaces in the model 

and when calculating volumes, those spaces are considered. But the issue is there are 

spaces with air which are not visible from exterior view. Anyway most of the spaces 

are identified if the blast is well distributed. Therefore the volume that we get from 

Agisoft is an intermediate value between in-situ and bulk densities and it is more close 

to the in-situ density.  

 

 

 

 

 

 

 

 

 

 

4.3.4 Advantages and disadvantages of Agisoft PhotoScan 

Advantages: 

✓ Very cheap (Full license for commercial use is $3499, academic use is $549) 

✓ Good Accuracy 

✓ Simple workflow, relatively simple interface 

✓ Good colour correction algorithm 

✓ Easy dataset merging 

Disadvantages: 

✓ Relatively more time consuming 

✓ Poor point cloud filtering 

✓ Requires data manipulation 

✓ Inefficient hardware utilization 
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4.4 Volume Calculation using Bentley ContextCapture 

4.4.1 Overview 

Same as in Agisoft, we can calculate the blasted volume in two methods; 

1. Measuring the blasted volume using pre blast and post blast faces 

2. Measuring the blasted volume of blasted rock pile 

In Agisoft we had to generate the Orthomosaic or the DEM to calculate volumes. So 

we only had a 2D image to calculate the blasted rock volume. But in ContextCapture 

we can use 3D Mesh for this purpose. Therefore it is easier to demarcate areas/ planes 

using ContextCapture. Acute3D Viewer which is a product of Bentley software 

package, can be used in this purpose. We can calculate distances, areas and volumes 

using this software. Most importantly we can mark all points, lines and polygons in a 

3D Mesh. 

4.4.2 Measuring the blasted volume using pre blast and post blast faces 

Here we have faced a difficulty as we didn’t have the capability to import or export 

shape files to ContextCapture. MicroStation is another product of Bentley software 

package, in which we can import shape files to the 3D Mesh and export shape files from 

the 3D Mesh. However we have demarcated blast area considering the locations of blast 

holes. 

Blast Holes 

Figure 4-14: Identification of Blast Holes 
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Figure 4-15: Demarcating the Blast Area 

Figure 4-16: Blast Area - Front View 

After identifying the locations of blast holes, we have marked the blast area as follows; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

We have selected the bench height as the height of the blast. Therefore to get the blast 

volume we have reduced the bench height from the mean level and got the cut volume 

above the custom plane. Also we can clearly observe that software has identified the 

holes (in blue) within the blast area and those will be calculated as the fill volume. 
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Figure 4-18: Blast Volume with 0.1m Sampling Distance 

 

 

 

 

 

 

 

 

 

 

Here we obtained a volume of 288.27 m3 for 0.59189 m sampling distance. Then we 

have reduced the sampling distance to 0.1 m and 0.05 m and obtained the volume 

measurements again. 

 

 

 

 

 

 

 

 

 

  

 

 

Figure 4-17: Volume Measurement 
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Figure 4-20: Volume Measurements with 0.1m & 0.05m Sampling Distances 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-19: Blast Volume with 0.05m Sampling Distance 
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Figure 4-22: Selecting the Extent of the Blasted Rock Pile 

4.4.3 Measuring the blasted volume of blasted rock pile 

Here we need to properly demarcate the area of the blasted rock pile. As mentioned 

before we can draw it in a 3D space, so we can avoid unwanted rocks and benches 

easily.  

 

 

 

 

 

 

 

  

 

 

 

Figure 4-21: Post Blast Rock Pile 
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Figure 4-24: Volume Measurements with 0.1m & 0.05m Sampling Distances 

Same as in previous case, we have decreased the sampling distance and got better 

volume measurements for the blasted rock pile. 

 

 

 

 

  

 

 

 

 

 

 

 

 

Figure 4-23: Blasted Rock Pile with 0.1m Sampling Distance 
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4.5 Measuring the depletion using DroneDeploy 

4.5.1 Selecting the right base plane 

There are three base-plane options available for volume calculation. They are Linear 

Fit, Lowest Point and Triangulated. Here we need consider about cut volume of the 

selected area. 

4.5.1.1 Measuring the volume above the Linear Fit  

 

 

 

 

 

 

 

 

 

4.5.1.2 Measuring the volume with Triangulated option 

 

 

 

 

 

 

 

 

 

Figure 4-25: Linear Fit Volume 

Figure 4-26: Triangulated Volume 
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Figure 4-28: Different Base Planes 

4.5.1.3 Measuring the volume above the Lowest Point  

 

 

 

 

 

 

 

 

  

Linear Fit (Best-fit plane) defines the base plane by fitting a perfectly flat plane, in 

3D, through the chosen edge points.  

Lowest Point calculates a horizontal base plane from the lowest edge point. This 

option is more suited to calculate the volume of benches or stockpiles on flat ground. 

Triangulated joins up all the edge points to create a 3D surface under your stockpile. 

This is perfect for long thin stockpiles. 

 

 

 

 

 

 

 

 

Figure 4-27: Volume above the Lowest Point 
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4.5.2 Cut and fill volumes 

Cut refers to the volume we would have to remove from the area. 

Fill refers to the volume we would have to haul in to that area. 

Cut and Fill volumes are automatically shown on the map when calculating volumes. 

The actual volume measurement calculation is Volume = Cut - Fill. 

According to our data, Final output of the Drone Deploy Software 

Method Cut Volume(m3) Fill Volume(m3) Actual 

Volume(m3) 

Linear Fit 240.3 -28.6 211.7 

Triangulated 240.7 -15.3 225.4 

Lowest Point 733.2 0 733.2 

 

4.5.3 Elevation Model 

Elevation model can be used for the volume calculation. 

 

 

 

 

 

 

 

 

 

Figure 4-29: Elevation Model 
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Post blast model contained 110 images and their accuracy of the three axes of 

coordinate as follows. Accuracy level is less than other methods of the volume 

calculations; 

X axis 1.2m, Y axis 0.5m, Z axis 0.4m 

 

 

 

 

 

 

 

 

4.5.4 Advantages and disadvantages of the DroneDeploy software 

Advantages of DroneDeploy 

• Quick Processing time than other methods 

• Supply 14-day trial online version 

• No need Advanced knowledge to operate 

• Output in many formats (JPG, TIFF, OBJ, LAS, SHP, DXF) 

• Live Map ( Real-Time Mapping) 

• Can be added up to 1000 images 

Disadvantages 

• Less Accuracy 

• Less Quality Output 

• Minimum number of options in the software 

Figure 4-30: Accuracy of the Model 
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Figure 5-1: Blasted Volume Comparison 

5 DISCUSSION 

5.1 Blasted Volume Comparison 

Below shows the blasted volume comparison of the values that we obtained from 

measuring the blasted tonnage (true value), total station survey and volumes that we got 

from Agisoft, Bentley and DroneDeploy softwares; 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this chart, vertical axis represents the in-situ volume of blasted the rock in m3 and 

the horizontal axis represents volume calculation method. As we can clearly see in the 

graph, GSMB volume is deviating drastically from the true volume. Therefore, that 

method shouldn’t have used to calculate the mining royalty.  

From the methods that we have occupied to calculate the blasted volume, the values 

that we have obtained from Bentley ContextCapture shows the least deviation from the 

true volume. Which implies that it is the most suitable software to obtain volume 

measurements using photogrammetric 3D modelling.  
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Anyway it shows a deviation of -13.5 m3 and -22.3 m3 from the true value. This maybe 

because we had to calculate the volume above an inclined plane. This inclined plane 

was not a uniform one. It was consisted of small holes and terrains. If we took the 

volume reading above a flat surface, then this volume will be very close to the true 

value. 

Volume measurement using Agisoft PhotoScan also shows a 17-27 m3 deviation while 

DroneDeploy shows the highest deviation among softwares which is 39 m3. Here we 

have used a 14-day trial version which is freely available on internet. They have 

restricted the accuracy of the volume measurement as this is a free version. When it 

comes to commercial versions, they might have a better accuracy. 

5.2 Effect and Errors of Total Station Survey 

There are some external factors affecting accuracy of this method. Total station used 

laser beam to the focus the survey points. Type and color of the reflecting surface will 

affect for the energy of the reflection of the laser beam. It leads to increase the error in 

measuring the slope distance. So when use the prism mode in high terrain level, the 

surface of the quarry rock is sharp or rough then the reflection point can be changed in 

the sunny time. It can effect for the 3D model. If we can increase the number of point 

measured, it can generate a high accuracy model. 

Total Station is remained frequently used instruments for conducting topographic 

surveys in heritage recording projects. Although the point coordinate measurements are 

very accurate, data collection is time consuming and we can’t map the original surface 

of bench using TS. Because of the when the constructing the 3D modeling, we had to 

assume that bench faces are even but natural case they are uneven. It will be a huge 

error for the volume calculation. 
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5.3 Polarization Effect of the Drone Images 

We have used a polarizer for our DJI Phantom 4 Pro drone. Now a day’s polarizer used 

in the many times in the drone imagining. Polarizer filter is most often used to,  

• Dark white clouds in the sky 

• Control the reflection from natural objects (tree leaves) and shiny surface in 

the ground 

• Reduce the glare effect from the surface of water bodies (lake, ocean, 

stream) 

The polarizer filter will block the unclean light. Those lights are bouncing and reflecting 

into various direction with the glare. Then filter works as the controller of the lights. 

The lights coming into a filter and it was filtered and it converted from bidirectional 

light rays to one direction rays. 

In our case, we used the DJI Phantom 4 Pro drone with a polarizer. It gives huge 

advantages for our quarry surveying. Because it controls the shiny effect of the quarry 

faces. Surveying is carried out on a sunny day at the time between 10.00 am to 1.00 

pm. If not used the polarizer definitely shiny effect can occur and reduce the degree of 

quality. Finally, it directly affects the quality of the drone images and processed models. 

Our observed model has very good quality with high appearance. 

 

Figure 5-2: Polarization Effect 
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6 CONCLUSIONS & RECOMMENDATIONS 

6.1 New suggestion for Drone  

DJI group announced latest drone technology for survey. DJI phantom 4 RTK is 

frequently releases new drone model in this year. It has huge leap forward and mainly 

focused on aerial mapping. Because of quadcopter built with Real Time Kinematic 

(RTK) capabilities. It gives highly accurate drone data for mapping. Phantom 4 RTK 

produces high resolution drone maps with 20MP sensor and 3D measurement. That are 

accurate within a few centimeters without using ground control points (GCP). Accuracy 

measurement are 1-3 cm in X and Y direction and 5cm in Z direction of position. Real 

time kinematic system integrated directly into the drone which is supply most efficient 

aerial GCPs. Phantom 4 RTK can achieve a ground sample distance (GSD) of 2.74cm 

at 100-meter flight altitude.  

RTK model combined with several coordinate systems such as GPS L1 L2, GLONASS 

L1 L2, Galileie Esa, BeiDow B1 B2. In areas with lack to RTK coverage, DJI phantom 

4 RTK allows for the use of Post Processed Kinematic (PPK) for the processing. Retail 

price of the DJI phantom 4 RTK is $6472. 
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Appendix 01: Agisoft PhotoScan Pre-Blast Face Report  
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Appendix 02: Agisoft PhotoScan Post Blast Full Quarry 
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Appendix 03: DJI Phantom 4 Pro - Drone Specifications 

Aircraft: 

Weight (Battery & Propellers 

Included) 

1388 g 

Diagonal Size (Propellers 

Excluded) 

350 mm 

Max Ascent Speed S-mode: 6 m/s 

P-mode: 5 m/s 

Max Descent Speed S-mode: 4 m/s 

P-mode: 3 m/s 

Max Speed S-mode: 45 mph (72 kph) 

A-mode: 36 mph (58 kph) 

P-mode: 31 mph (50 kph) 

Max Tilt Angle S-mode: 42° 

A-mode: 35° 

P-mode: 25° 

Max Angular Speed S-mode: 250°/s 

A-mode: 150°/s 

Max Service Ceiling Above Sea 

Level 

19685 feet (6000 m) 

Max Wind Speed Resistance 10 m/s 

Max Flight Time Approx. 30 minutes 

Operating Temperature Range 32° to 104°F (0° to 40°C) 

Satellite Positioning Systems GPS/GLONASS 

Hover Accuracy Range Vertical: 

±0.1 m (with Vision Positioning) 

±0.5 m (with GPS Positioning) 

Horizontal: 

±0.3 m (with Vision Positioning) 

±1.5 m (with GPS Positioning) 
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Camera: 

Sensor 1’’ CMOS 

Effective pixels: 20M 

Lens FOV 84° 8.8 mm/24 mm (35 mm format 

equivalent) f/2.8 - f/11 auto focus at 1 m - ∞ 

ISO Range Video: 

100 - 3200 (Auto) 

100 - 6400 (Manual) 

Photo: 

100 - 3200 (Auto) 

100- 12800 (Manual) 

Mechanical Shutter Speed 8 - 1/2000 s 

Electronic Shutter Speed 8 - 1/8000 s 

Image Size 3:2 Aspect Ratio: 5472 × 3648 

4:3 Aspect Ratio: 4864 × 3648 

16:9 Aspect Ratio: 5472 × 3078 

PIV Image Size 4096×2160(4096×2160 24/25/30/48/50p) 

3840×2160(3840×2160 24/25/30/48/50/60p) 

2720×1530(2720×1530 24/25/30/48/50/60p) 

1920×1080(1920×1080 24/25/30/48/50/60/120p) 

1280×720(1280×720 24/25/30/48/50/60/120p) 

Still Photography Modes Single Shot 

Burst Shooting: 3/5/7/10/14 frames 

Auto Exposure Bracketing (AEB): 3/5 bracketed 

frames at 0.7 EV Bias 

Interval: 2/3/5/7/10/15/20/30/60 s 

 

 


